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Accuracy assessments for headwater stream maps in western North Carolina

Amanda Marie Johnson
Department of Forestry and Environmental Resources

North Carolina State University

ABSTRACT

Headwater streams are essential to downstream water quality, therefore it is important they are 

properly represented on maps used for stream regulation. Current maps used for stream regulation, such 

as the United States Geological Survey (USGS) topographic maps and Natural Resources Conservation 

Service (NRCS) soil survey maps, are outdated and do not accurately nor consistently depict headwater 

streams. In order for new stream maps to be used for regulatory purposes, the accuracy must be known 

and the maps must show streams with a consistent level of accuracy. This study assessed the valley 

valley presence/absence and stream length accuracy of the new stream maps created by the North 

Carolina Center for Geographic Analysis (CGIA) for western North Carolina. The CGIA stream map 

does not depict headwater streams with a consistent level of accuracy. This study also compared the 

accuracy of stream networks modeled using the computer software program, Terrain Analysis using 

Digital Elevation Models (TauDEM), to the CGIA stream map. The stream networks modeled in 

TauDEM,also do not consistently predict the location of headwater streams across the mountain region 

of the state. The location of headwater streams could not be accurately nor consistently predicted by 

solely using aerial photography or elevation data. Other factors such as climate, soils, geology, land 

use, and vegetation cover should be considered to accurately and consistently model headwater stream 

networks.
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INTRODUCTION

Purpose

Federal, state, and local agencies rely on maps, such as the USGS 1:24,000 topographic, NHD 

digital USGS topographic, and NRCS 1:100,000 soil survey maps, to regulate streams or plan for 

restoration. These maps were not constructed with sufficient detail to be used as stream maps and are 

outdated (Drummond, 1974). Topographic and soil survey maps poorly depict true stream networks 

because they often do not show first order streams, in addition to many second and third order streams 

(Morisawa, 1957; Coffman et al., 1972; Benda et al. 2005).1 The first, second, and third order streams 

in a watershed are the headwater streams of a stream network (Strahler 1957). USGS maps are known 

to have inconsistent drainage densities among quadrangles, which affects the number and location of 

streamlines (lines on a map that represent streams) depicted on a map (Colson et al. 2008). Because of 

this, regulating headwater streams in areas where two quadrangles meet can be difficult. A study 

showed NRCS soil maps overpredicted total headwater stream length by an average of 54% in nine 

watersheds across the state of North Carolina (Colson et al. 2008). The same study showed USGS topo  

maps underpredicted total headwater stream length by an average of 34% (Colson et al. 2008). 

Headwater streams have a significant impact on downstream water quality, and therefore it is important 

that they are accurately depicted on the maps used by agencies in order to ensure proper regulation 

(Brooks and Colburn 2011). The inconsistency and inaccuracies are due to the fact that USGS topo and 

NRCS soil surveys were not intended to be used for stream regulation (Russell 2008).                             

North Carolina officials saw the need for a state-wide stream map that more accurately depicts 

the position of streams on the landscape. A new stream map was created by CGIA, but funding only 

allowed for a stream map to be developed for the mountain region of the state (Appendix 1). 

Concurrently, a separate stream mapping study by the North Carolina Division of Water Quality 

1. A stream network includes all of the streams, of any order, that are within a defined drainage basin or watershed.
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(DWQ) was in progress to “develop a stream map for the state that more accurately depicts first and 

second order streams” (Russell 2008). Based on field data, DWQ has been able to use different 

variables to model headwater streams for areas in the coastal plain and piedmont regions of the state. 

Although nine mountain watersheds have been field-mapped by DWQ, models for headwater streams 

have not been developed for any areas in the western portion of the state. It may be possible to combine 

the stream mapping efforts in North Carolina between the two agencies by using the streamlines 

created by CGIA and mountain field data from DWQ. The two agencies have already agreed “to 

integrate the headwater stream mapping products with CGIA to produce one North Carolina stream 

map that meets multiple use requirements” (Russell 2008). The first step to this integration is 

determining how well the CGIA stream map depict headwater streams.

The two most important attributes of a stream map are known accuracy and consistent accuracy. 

If the accuracy of the CGIA stream map is known and is shown to be consistent, it is possible to use the 

map as a tool for regulatory purposes. In order to determine the accuracy of the CGIA stream map, I 

performed accuracy assessments using the nine mountain watersheds that were field-mapped by DWQ. 

The accuracy assessments for the CGIA streamlines for each of the nine watershed is the first part of 

this study. There are two components to the accuracy assessment. The first component includes an 

evaluation of a map's correct depiction of the presence or absence of streams within the valleys of a 

watershed, called the valley presence/absence accuracy. The second component of an accuracy 

assessment determines the difference between the total stream length of a map compared from the 

field-verified total stream length in a watershed, called the stream length accuracy. 

For the second part of this study, I chose two different methods to model stream networks using 

a computer software program called Terrain Analysis Using Digital Elevation Models (TauDEM) 

(Tarboton 2009). I also performed accuracy assessments for the stream networks that were created 

using TauDEM. This study compares the headwater stream accuracies of TauDEM stream networks to 
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the CGIA streamlines. TauDEM is a computer program that is fast, simple and free to use, whereas 

CGIA was an effort that took substantial amounts of time and money to complete. The first purpose of 

this study was to determine the accuracies and consistencies of headwater streams on  the CGIA stream 

map. The second purpose of the study was to compare the CGIA stream map accuracies to other 

methods used to model stream networks that were less costly and time-consuming than the CGIA 

effort.

Importance of Headwater Streams

Headwater streams constitute 60 to 85% of the total stream length of a network, and drain 70 to 

90% of the drainage basin area (Benda et al. 2005, MacDonald and Coe, 2007). In a watershed, 

“headwater streams represent the maximum interface with the landscape and therefore are 

predominantly accumulators, processors, and transporters of materials from the terrestrial system" to 

the larger order streams (Vannote et al., 1980; Kyshakevych 2009). They perform essential functions 

that benefit water quality such as retention of organic debris, cycling of nutrients and sedimentation, 

flood control, and dissipation of energy from runoff that lessens downstream erosion (MacDonald and 

Coe 2007). Headwater streams host a myriad of macroinvertebrate species, many of which are essential 

to nutrient cycling and transport to the entire stream network (Meyer and Wallace 2001; Gomi et al. 

2002, Adams and Spotila 2005). They are able support macroinvertebrates and other small species by 

providing suitable breeding and rearing sites and allowing for species migration across the landscape 

(Zale 1989). Because headwater streams provide so many important functions and include so much of 

the total stream length in a watershed, it is imperative that they are properly regulated.
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Headwater Stream Formation

Headwater streams in mountainous regions begin from three possible channel-initiation 

processes: overland flow, landsliding, and seepage erosion (Montgomery and Dietrich 1989). The 

starting point of a first order stream within a valley is the stream origin, or channel head. The first 

process that can form channel head is overland flow. Overland flow occurs when the precipitation rate 

exceeds the infiltration rate (Jaegar et al. 2007). The rate at which water can infiltrate the soil depends 

on porosity and permeability of the soil, meaning less permeable soils with lower porosity will have 

slower infiltration rates (Kyshakevych 2009). Saturation excess is a process that occurs when more 

precipitation falls onto soil that is already saturated. The precipitation will then become runoff. Other 

watershed characteristics, such as the amount and type of vegetation cover, potential 

evapotranspiration, climate, geology, drainage area, and slope will also affect the infiltration rate and 

overland flow in a watershed (Adams and Spotila, 2005). Overland flow is responsible for most 

channel heads in watersheds with lower-gradient slopes (Montgomery and Dietrich 1989). The 

channel-initiation points from overland flow are often considered gradual (Montgomery and Dietrich 

1989). Channel heads caused by overland flow “are characterized by signs of concentrated flow 

upslope of the channel head as evidence by the presence of debris such as leaves and small twigs piled 

behind rooted vegetation and plants trained down slope” (Jaegar et al. 2007).

The second channel-initiation process in mountainous areas is landsliding and is more common 

in areas with steeper slopes (Montgomery and Dietrich 1989). Landslides are caused by subsurface 

water flow in areas with a steep gradient (Adams and Spotila, 2005). In watersheds with steeper slopes, 

the water moves into the top soil layer and then horizontally towards deep valleys. The subsurface 

water flow increases the pore pressure within the soil layer, which reduces the ability of the soil to stay 

in place (Montgomery and Dietrich 1989). When precipitation falls in watersheds with steeper slopes, 

the water moving across the land will have a higher velocity, causing channel-initiation points to often 
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times be concave and abrupt (Montgomery and Dietrich 1989). Channel heads caused by landslides can 

be “identified by the presence of recent mass wasting scars” (Jaeagar et al. 2007). The same watershed 

characteristics that affect overland flow can also affect landsliding processes. 

The third channel-initiation process is seepage erosion, which occurs on both gentle and steep 

slopes. (Montgomery and Dietrich 1988; Montgomery and Dietrich 1989). The seepage erosion process 

occurs from convergent subsurface flow, similar to landsliding. However, the channel heads formed by 

seepage erosion are not as abrupt or severe as those formed by landsliding. Channels formed from 

seepage erosion often “begin as discontinuous channel segments with evidence of headcut 

undermining,” and are difficult to identify without field-based evidence (Montgomery and Dietrich 

1988). 

CGIA Streamlines

In the summer of 2004, the Studies Act (SL2004.161) called for a plan from the NC Geographic 

Information Coordinating Council (GICC) and NC Department of Environmental and Natural 

Resources (NCDENR) to create new maps of surface waters (NC Stream Mapping Program).The 

Stream Mapping Study Working Group, a group composed of consultants, academic advisers, and 

government employees from federal, state, and local levels, drafted an implementation plan that studied 

different methodologies that could be used to produce maps, potential cost, an estimated time-frame, 

and the key benefits of the project (NC Stream Mapping Program). 

Also during 2004, Hurricanes Ivan and Frances caused massive flooding and millions of dollars 

worth of damage in western North Carolina. In 2005, the Hurricane Recovery Act (SL2005-1) was 

passed, declaring 19 North Carolina mountain counties disaster areas and in need of assistance. The  act 

also appropriated funds for the NC Stream Mapping Project to develop new stream maps for western 

North Carolina (NC Stream Mapping Program). It was decided that CGIA, a part of NCDENR, would 
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be the lead agency that would manage the development of the new streamlines. CGIA created the new 

streamlines using methodologies discussed in the “Implementation Plan to Improve the Mapping and 

Digital Representations of Surface Waters in North Carolina” (Implementation Plan), written in 2004 

by the original Stream Mapping Study Working Group (NC Stream Mapping Program). CGIA created 

the new streamlines using recent aerial photography, Light Detection and Ranging (LIDAR) data, and 

ArcGIS. ArcGIS is a geographic information systems (GIS) computer software program that allows the 

user to view, create, edit, and maps and analysis spatial data. All streamlines were drawn in using aerial 

photography, as this method was shown to be most accurate in the Implementation Plan (NC Stream 

Mapping Program). When streams could not be determined with aerial photography, ArcHydro, a 

collection of stream network delineation tools in ArcGIS, was used (NC Stream Mapping Program). A 

6-acre (0.024281 km2) drainage area threshold was used for the stream network delineation tool in 

ArcGIS, based on a single study of urban streams in Greensboro, NC (NC Stream Mapping Program). 

When modeling stream networks using computer software programs such as ArcGIS, the chosen 

drainage area threshold is important. In nature, streams in watersheds with different slopes and will 

have different drainage areas (Montgomery and Dietrich 1992). The slope-drainage area relationship is 

further explained in the Methods section. To capture headwater streams, streamlines were extended 200 

feet (69.6 m) beyond the modeled stream origin in order to ensure penetration of the 6-acre ( 2.4281 ha 

or 0.024281 km2) drainage area (NC Stream Mapping Program). The main focus for the CGIA stream 

map was to improve the horizontal accuracy of streams on maps, not to accurately show headwater 

streams (NC Stream Mapping Program).

Headwater Stream Spatial Dataset

In a separate project from the NC Stream Mapping Project, DWQ began work on the Headwater 

Stream Spatial Dataset (HSSD) in 2004. The HSSD aims to improve the representation of headwater 
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streams on maps that can be used by agencies such as DWQ, United States Army Corps of Engineers 

(USACE), and the Environmental Protection Agency (EPA) for research and regulatory purposes for 

North Carolina (Russell 2008). For the HSSD, DWQ collects field data of intermittent and perennial 

stream origins in selected watersheds and uses these data to create a field-based stream network in 

TauDEM.2 Once a field-based stream network is created, GIS analysis of watershed characteristics such 

as slope, drainage area, soils, and precipitation can be used to create a predictive model of streams for a 

different location with similar characteristics (Russell 2008). 

The selected watersheds are chosen to represent the Omernik and EPA Level IV ecoregions that 

occur in North Carolina (Omernik 1987; Environmental Protection Agency 2011). Level IV ecoregions 

are the finest level of organization for ecological regions based on “geology, physiography, vegetation, 

climate, soils, land use, wildlife, and hydrology” (Environmental Protection Agency 2011). Because the 

Level IV ecoregions represent landscapes with similar characteristics, the sites chosen for the HSSD 

“were stratified by ecoregion, given the assumption that ecoregions will control for landscape 

variability” (Russell 2008). The data that are derived from GIS analysis of the selected watersheds act 

as a sample of the characteristics of the ecoregion. Using statistical analysis and logistic regression, 

predictive models are created for each ecoregion by DWQ using the field-mapped watersheds (Russell 

2008).3

METHODS

Study Areas

There are 5 different ecoregions that are represented by the nine watersheds (Table 1). Out of 

2 Intermittent streams flow seasonally and perennial streams flow throughout the year. 

3 “Logistic regression is a statistical method for analyzing a dataset in which there are one or more independent variables that determine 
an outcome. The outcome is measured with a dichotomous variable (in which there are only two possible outcomes)” (medcalc.org). For 
the HSSD, the two possible outcomes are 0 “not a stream” or 1 “stream” for each cell of a DEM. The cells with a value of 1 will make up 
a stream network.
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the field-mapped watersheds, four are within the Eastern Blue Ridge Foothills ecoregion, two are 

within the Southern Metasedimentary Mountains, and there is one watershed in each of the Southern 

Crystalline Ridges and Mountains, High Mountains, and Broad Basin ecoregions (Figure 1). The 

watersheds where stream origins were mapped by DWQ are mostly forested and occur on public lands 

to minimize the effects of land use disturbance (Table 2) (Russell 2008). The size of the watersheds 

range from 1.09 to 6.43 km2 ( 269 to 1,588 acres) with an average of 45 stream origins mapped per 

watershed (Table 2). The slopes and contributing upstream drainage areas were extracted from GIS 

analysis at the stream origins for each watershed (Table 3). The watersheds with the highest slopes also 

have the lowest drainage areas. These data demonstrate the inverse slope-drainage area relationship 

discussed by Montgomery and Dietrich (1989).

Table 1. Level IV Ecregion Descriptions. A brief description of the five Level IV ecoregions used 
in this study, arranged from the most western ecoregion to the most eastern in the mountains.

Level IV Ecoregion Description

High Mountains 
(HM)

• Boreal-like climate than surrounding regions
• Frigid soils rather than mesic soils
• Several disjunct high-elevation areas generally above 1,375 meters

Southern 
Metasedimentary 
Mountains (SMM)

• Contains rocks that are not as strongly metamorphosed as seen in 
Southern Crystalline Ridge and Mountains

• Steep, dissected, and densely forested mountains
• Mostly forested

Broad Basin (BB)

• Drier, lower elevations, and less relief than Southern Crystalline 
Ridge and Mountains and Southern Metasedimentary Mountains

• Mostly forested, but overall has more pasture, cropland, industrial 
land uses, and human settlement than other Blue Ridge ecoregions

Southern Crystalline 
Ridges and 

Mountains (SCRM)

• Greater relief and higher elevations than Broad Basin and Eastern 
Blue Ridge Foothills

• Elevation ranges 400 to 1500 meters

Eastern Blue Ridge 
Foothills (EBRF)

• Warmer and drier than most other Blue Ridge ecoregions
• Lower elevations (300 to 850 meters)
• More Piedmont influences
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Figure 1. A map of the locations of each watershed used in this study.
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Table 2. Watershed Characteristics. Characteristics of each of the nine watersheds used in this 
study. The table is arranged from smallest to largest watershed area. The percentage of open 
areas in each watershed includes any land cover that is not considered shrub land or forested. 
This means cropland, pasture, and developed areas are considered open area (NLCD 2006).

Table 3. Drainage Areas and Slopes at Stream Origins. The contributing upstream drainage area 
and slope taken at the field-verified stream origins.

Collecting Field Data

The flow regimes of the stream origins were identified using the Methodology for Identification 

of Intermittent and Perennial Streams and Their Origins Version 4.11. This is a method that evaluates 

the morphology, hydrology, and biology as indicators of duration of flow at a stream origin (NCDWQ 

2010). Only intermittent and perennial stream origins were mapped for this study because USACE and 

11

Watershed  

EBRF

White 2.80 4.61 0
4.64 4.26 6

South 6.03 2.91 10
Brushy 7.24 3.60 7

SMM
1.09 4.13 0
1.18 4.23 4

HM 2.93 1.72 3
BB Hayes 6.62 4.12 55

SCRM Bent 8.47 2.52 2
Mean 4.56 3.57 9.67

Ecoregion Area (km2)
Drainage 
Density 

(km2/km)

% of Open 
Area 

Dysartsville

Smokies Trans
Smokies Meta
Smokies High

Watershed Watershed Slope Mean Slope Range

0.11 0.51 0.47 0.71
0.26 0.48 South 0.39 0.64

South 1.38 5.52 0.38 0.71
2.15 21.94 0.31 0.31

White 2.23 11.55 White 0.23 0.43
Bent 2.56 22.15 Bent 0.20 0.47

Brushy 3.20 24.08 0.19 0.40
Hayes 3.34 19.30 Brushy 0.16 0.42

3.63 18.97 Hayes 0.13 0.25

Drainage Area 
Mean (acres)

Drainage Area 
Range (acres)

Smokies Trans Smokies Trans
Smokies High

Smokies Meta
Smokies Meta Smokies High

Dysartsville

Dysartsville



DWQ do not typically regulate ephemeral streams.4 To map stream origins, DWQ began at the most 

downstream point of the watershed to be studied. Using aerial photographs and USGS topographic 

maps as guidance, they walked up the stream until a tributary was observed (Russell 2008). The 

tributary was then followed until they encountered another tributary or reached the stream origin 

(Russell 2008). This process was repeated until the entire stream network was mapped. The stream 

origin points were taken with a mapping-grade GPS unit. In instances where the mapping-grade GPS 

unit could not acquire enough satellites, a less accurate recreational-grade GPS unit was used.

Creating Digital Elevation Models

In order to create the field-verified stream networks, a base DEM was created from LIDAR bare 

earth points (Appendix 2). The bare earth data were downloaded from the North Carolina Floodplain 

Mapping Program (ncfloodmaps.org). The bare earth points are given as a text file with values for x 

(latitude), y (longitude), and z (elevation). The x, y, and z values were converted into a point shapefile 

using ArcCatalog (a part of ArcGIS) Version 9.3.1. In ArcMap (a part of ArcGIS) Version 9.3.1, the 

point shapefile was converted into a raster with a 5 meter by 5 meter resolution. Each cell, or pixel, of 

the raster represents 25 m2 of the earth's surface. There are approximately four bare earth points of data 

for each cell of the raster. This raster is the base DEM that will be used in TauDEM (Tarboton 2009). 

Creating Field-verified Stream Networks

To create the field-verified stream networks, I used TauDEM Version 4.0 and ArcMap Version 

9.3.1 (Appendix 2) (Tarboton 2009). Using the base DEM, a stream network can be modeled using 

TauDEM as a toolbox in ArcMap (Appendix 3). The initial stream networks created by TauDEM were 

4 Ephemeral streams carry stormwater from precipitation, but do not experience continuous flow and lack the stream origins 
features that indicate some sort of continuous flow.
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edited to fit the field-mapped stream origins. The edited streamlines are the field-verified stream 

networks that are used for the accuracy assessments.

Modeling Stream Networks in TauDEM 

I used two different methods in TauDEM to create stream networks for this study. The first was 

the DEM curvature based method (Appendix 2). This method uses the Peucker-Douglas algorithm to 

determine which cells of the DEM are considered to be either convex or concave (Peucker and Douglas 

1975, Band 1986). The cells are grouped in a 2 by 2 matrix across the extent of the DEM. The elevation 

data for each cell is extracted from the DEM and cells are evaluated in the matrix.The convex cells 

have the highest elevation values of the matrices and are marked as ridges (or not streams) with a value 

of 0 (Tarboton 2004). The concave cells have the lowest elevation values of the matrices and marked as 

streams with a value of 1. The stream cells will make up the streamlines within the watershed 

(Tarboton 2004). When using the Peucker-Douglas algorithm alone, the stream cells often times lack 

connectivity and do not form continuous streamlines. For the DEM curvature based method, the idea of 

thinning, discussed in length by Band (1986), is used to produce connected streamlines (Tarboton 

2004). In order to connect the stream cells, the contributing area of the stream cells is calculated and a 

contributing area threshold is determined. The cells that exceed the threshold have the most 

contributing area and are the lowest points on the landscape. The lowest elevations are most likely 

where water will flow to on the landscape and support stream flow. The cells that exceed the 

contributing area threshold are marked as streams and are used to connect the gaps in the streamlines 

(Tarboton 2004). 

The second method I used to delineate stream networks was the area and slope threshold 

method (Appendix 2). The area and slope threshold is determined by the following inequality:

ASy > T (1)

13



where A is the drainage area and S is slope. For the area and slope threshold method in TauDEM, the 

values for y and T are chosen by the user (Tarboton 2004). Based on empirical data of mountainous 

terrain in the western region of the country, Montgomery and Dietrich (1992) found that a value of 2 

for y and a threshold (T) of 200 adequately determined the location of streams. They determined “that 

an inverse relationship between the drainage area contributing to a channel head (source area) and the 

local valley slope defines a topographic threshold between channeled and unchanneled regions of the 

landscape” (Montgomery and Dietrich 1992). In areas with steeper slopes, less drainage area is 

required to for channel initiation. Conversely, areas with gentler slopes require a larger area to supply 

enough water to form streams in a watershed. 

Each cell in the DEM has drainage area and slope values. Drainage area is calculated from all of 

the number of cells in the DEM that are upslope, and slope is calculated from the elevation data. Using 

these data and the equation (1) above, a value is calculated for each cell. If the value exceeds the 

threshold (T) chosen by the user, it is given a value of 1 and is considered a stream. If the value is less 

than the threshold chosen by the user, it is given a value of 0 and is not a stream. The collective cells 

make up streamlines, and the streamlines in a watershed make up the stream network. I felt the 

threshold where T = 200, as determined by Montgomery and Dietrich (1992), would be a starting point 

for this study, since the watersheds I used are also located across mountainous terrain. I tested three 

different threshold values to determine how the level of accuracy for each watershed changed by 

increasing the threshold for the area and slope method. I used the threshold values of 150, 200, and 

300.

Performing Accuracy Assessments

For this study, I performed accuracy assessments for CGIA and modeled streamlines from the 

different methods in TauDEM. The accuracy assessments for each watershed include an evaluation of 
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the model's ability to correctly predict the valley presence/absence of streams and total stream network 

length. The true skill statistic (TSS) was used to evaluate the ability of a method to correctly predict the 

location of streams by the use of omission and commission errors (Figure 2; Table 3) (Allouche et. al., 

2006; Russell 2008). The TSS values range from 0 to 1. The highest possible value for a TSS is 1, 

meaning a model accurately predicted the location of every field-verified stream and did not predict 

any streams in valleys that do not have field-verified streams. 
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The possible outcomes using the TSS are: 

a) True positive   – the number of valleys correctly predicted to have streams

b) False positive   – the number of valleys predicted to have streams that do not actually have 

streams

c) False negative   – the number of valleys that have streams, but were not predicted by the model

d) True negative  - the number of valleys correctly predicted to not have streams

Figure 2. Possible Outcomes for the TSS. An example of true positive, true negative, and false 
negative streamline segments in a watershed using field-based data and CGIA streamlines.

Table 4. TSS Formulas. Source : Allouche et al., 2006.
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±
a. true positive

c. false negative

b. false positive

Measure Formula Notes

Sensitivity  a / (a + c)

Specificity  d / (b + d)

TSS (sensitivity + specificity) -1

n  a + b + c + d

“n” is determined by counting the number of 
valleys in a watershed using the gord grid created 
in TauDEM. For this study, all the valleys with a 

gord value of 3 or higher were counted. “d” can be 
calculated by the following: n – (a + b + c) 



RESULTS

CGIA Streamlines

With a few exceptions, the CGIA stream map produced the highest TSS values (Figure 3). The 

second best method was DEM curvature based, with the average of TSS values only 9% different from 

the CGIA streamlines (Table 4). On average, the DEM curvature based method performed better than 

all of the thresholds used for the area and slope method. The average TSS for T = 200 shows only a 3% 

difference from the average TSS of the curvature based method. The South Mountain watershed has the 

largest range of TSS values between all of the methods, with values ranging from 0.38 from the T = 

150 to 0.67 from the curvature based method. 

Figure 3. A graph showing the TSS values for each method. The watersheds are arranged from 
the lowest to the highest TSS value of the CGIA streamlines.
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Table 5. The percent differences from CGIA. Percentages with (-) means the TSS for that method 
was higher than the TSS for the CGIA streamlines. 

The three watersheds with the highest TSS values are the Hayes, Brushy, and Dysartsville (Figure 4). 

These three watersheds also had the highest upstream drainage area average and 3 out of the 4 lowest 

slope averages measured at the field-mapped stream origins (Table 3). The location of headwater 

streams may be easier to determine with aerial photography in areas with lower slopes, hence the 

higher TSS values. The Hayes watershed had the highest TSS value at 0.86, and the substantially 

highest percentage of open land cover with over 50% of open area in the watershed (Table 2). The open 

areas on the aerial photograph that were used to delineate the Hayes watershed most likely attributed to 

the high TSS value. 

The South Mountain watershed had the second highest open area land cover with approximately 

10% of open land, but was tied for the lowest TSS value of 0.58. The low specificity and high 

percentage of percent error of total stream length for South Mountain shows that the number and the 

length of the headwater streams in the watershed were overpredicted (Table 5). The CGIA streamlines 

that are in the open area of the watershed are somewhat accurately depicted and the stream lengths are 

similar to actual stream lengths (Appendix 4). However, in the forested areas of the watershed, the 

stream lengths greatly exceed the true stream origins and the number of false positives increases as 
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% Difference from CGIA TSS Values
Watershed Curvature T = 150 T = 200 T = 300

South (-) 14 49 39 25
Smokies Trans 0 29 2 12

Dysartsville 2 4 0 16
Bent 3 21 16 14

Smokies High 6 21 15 (-) 25
Brushy 6 9 4 21
White 8 1 5 18

Smokies Meta 19 25 14 6
Hayes 20 30 15 20
Mean 9 21 12 18



well.

The CGIA stream map overpredicted the total length of the stream network for all of the nine 

watersheds (Table 5). CGIA overpredicted the number of streams for two-thirds of the watersheds. In 

the Smokies High watershed, CGIA overpredicted the number of streams by over 200%. The White 

Mountain and Smokies Transition watersheds were the only two watersheds that CGIA underpredicted 

the total number of streams, but both have overpredicted stream lengths. The CGIA stream map 

correctly predicted the number of streams for Smokies Metasedimentary watershed, but overpredicted 

the total stream length as well, by 38%. It is evident that, in most cases, the CGIA streamlines 

inaccurately depict the actual length of the headwater streams.

Figure 4. A bar chart showing the sensitivity, specificity, and TSS values for the CGIA streamlines 
in each watershed. The numbers shown within the chart are the TSS values. 
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Table 6. Number of Stream Origins and Stream Length Accuracies for CGIA Streamlines. The 
the number of stream origins and the total stream length accuracy assessment for the CGIA 
streamlines. The stream lengths for all watersheds were overpredicted.

DEM Curvature Based Method

The watersheds that had the higher TSS values for CGIA (Hayes, Brushy, Dysartsville, and 

White Mountain) also had the highest TSS values for the DEM curvature based method (Table 8). The 

same is true for the watersheds with the lower TSS values (Smokies Transition, Bent Creek, and 

Smokies High), with the exception of South Mountain. The South Mountain watershed had the highest 

TSS value when using the curvature method than all other methods. However, even though the 

curvature method produced a higher TSS value for South Mountain, a TSS value of 0.67 is still fairly 

low. 

The DEM curvature based method had a highest average specificity of all the other methods, 

including the CGIA streamlines method. A high specificity means there was a low number of false 

positives for each watershed, so the number of streams were not overpredicted. However, the DEM 

curvature method has an average low sensitivity. This suggests the method is has a high number of 

false negatives, so the method is predicting less streams than actually exist. This is also reflected in the 
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Watershed Difference

48 49 1 19.76 23.01 16
White 42 39 -3 12.92 15.39 19
Hayes 63 75 12 27.26 34.48 26

13 13 0 4.98 6.87 38
Brushy 64 93 29 26.07 35.99 38

14 13 -1 4.49 6.25 39
Bent 77 93 16 21.34 30.72 44

South 46 75 29 18 31.12 73
9 29 20 5.03 11.49 128

Mean 42 53 11 15.54 21.70 47

Field-Verified 
# of  Stream  

Origins

CGIA # of  
Stream  
Origins

Field-verified 
Length (km )

Model Length 
(km )

Model 
Length Error  

 % Over 
Predicted

Dysartsville

Smokies Meta

Smokies Trans

Smokies High



low model stream length error percentage (Table 8). On average, the curvature method has a tendency 

to underpredict the number of headwater streams in a watershed. 

Table 7. The table shows valley presence/absence and stream length accuracy assessments for the 
DEM curvature based method. 

Area and Slope Method, T = 150

Even though the area and slope method with T = 150 produced the lowest average TSS values 

of all the methods, a similar pattern of TSS values for the watersheds can be seen. The same watersheds 

have high TSS values and low TSS values using the area and slope method with a 150 threshold as the 

previous methods. The Dysartsville, Brushy, and Hayes watersheds have the lowest slopes, highest 

average drainage area, and the highest TSS values (Table 5, Table 6). The Dysartsville watershed had a 

reasonably high TSS value, an extremely high sensitivity value, and high specificity (Table 9). This 

means a majority of streams were correctly predicted, and a very low number of actual streams were 

missed by the method. In watersheds that have high slope means and ranges and low average drainage 

areas, such as South Mountain and Smokies Transition, had very low specificity values when the area 
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DEM-based Curvature Method
Presence/Absence Accuracy Assessment Stream Length Accuracy Assessment

Watershed Sensitivity Specificity TSS

0.62 0.93 0.55 4.49 4.58 2
Bent 0.65 0.91 0.56 21.34 27.46 29

0.67 0.96 0.63 5.03 6.58 31
0.69 0.95 0.64 4.98 5.26 6

South 0.76 0.91 0.67 18.00 20.09 12
Hayes 0.73 0.96 0.69 27.26 26.73 (-) 2
White 0.77 0.94 0.71 12.92 12.77 (-) 2
Brushy 0.85 0.92 0.77 26.07 30.44 17

0.82 0.98 0.79 19.76 17.37 (-) 12
Mean 0.73 0.94 0.67 - - 13

Field-
verified 

Length (km)

Model 
Length (km)

Model Length 
Error % 

Over/Under 
Predicted

Smokies Trans 

Smokies High
Smokies Meta

Dysartsville



and slope method with a threshold of 150 was used. This means the method was overpredicting the 

number of headwater streams in the watershed, which can also be seen by the percent error of 

overpredicted stream length (Table 9). 

A low threshold works best in watersheds with lower-gradient slopes and larger drainage areas. 

For watersheds that have higher-gradient slopes, there will be a higher number of cells in the DEM that 

exceed the threshold. The method will determine more cells as streams when modeling a stream 

network in valleys that do not actually contain headwater streams. When a threshold is too low, the 

method will overpredict the number and length of streams in watersheds with steep slopes. The area 

and slope method with a threshold of 150 works well for lower-gradient areas, but performs poorly in 

mountainous areas with steep slopes. 

Table 8. The table shows valley presence/absence and stream length accuracy assessments for the 
area and slope method when T = 150.
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Area/Slope T = 150
Presence/Absence Accuracy Assessment Stream Length Accuracy Assessment

Watershed Sensitivity Specificity TSS

South 0.86 0.52 0.38 18.00 37.15 106
0.92 0.49 0.42 4.49 13.73 206

Bent 0.77 0.69 0.46 21.34 45.94 115
0.83 0.70 0.53 5.03 15.58 210
0.77 0.82 0.59 4.98 11.71 135

Hayes 0.68 0.91 0.60 27.26 27.14 -0.4
Brushy 0.89 0.86 0.75 26.07 34.59 33
White 0.91 0.86 0.76 12.92 17.74 37

0.98 0.80 0.78 19.76 25.17 27
Mean 0.85 0.74 0.59 - - 97

Field-
verified 

Length (km)

Model 
Length (km)

Model Length 
Error % 

Over/Under 
Predicted

Smokies Trans 

Smokies High
Smokies Meta

Dysartsville



Area and Slope Method, T = 200

The same pattern from the area and slope method when T = 150 can be seen for T = 200, with 

the exception of the White Mountain watershed. The South Mountain, Bent, and Smokies watersheds 

still have lowest TSS values and the Brushy, Dysartsville, White, and Hayes watershed have the highest 

(Table 10). The average specificity and TSS values increased when the threshold for the area and slope 

method increased. The increase in average specificity and the decrease in the average % error of stream 

length from the 150 threshold indicate that the increased threshold is not overpredicting as many 

streams. Fewer cells of the DEMs for the watersheds are exceeding the 200 threshold. The average 

sensitivity is the same for the 150 and 200 area and slope thresholds, meaning the 200 threshold is still 

missing the about the same number of streams. However, since the models have less overpredicted 

streams than the 150 threshold, the 200 threshold is considered a more accurate representation of 

headwater streams. The threshold of 200 produced, on average, more accurate stream networks than the 

150 and 300 thresholds for the area and slope method.

Table 9. The table shows valley presence/absence and stream length accuracy assessments for the 
area and slope method when T = 200.
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Area/Slope T = 200
Presence/Absence Accuracy Assessment Stream Length Accuracy Assessment

Watershed Sensitivity Specificity TSS

South 0.87 0.57 0.44 18.00 34.10 89
Bent 0.72 0.77 0.49 21.34 38.08 78

0.83 0.74 0.57 5.03 11.30 125
0.92 0.66 0.58 4.49 11.48 156
0.77 0.91 0.68 4.98 9.81 97

Hayes 0.84 0.89 0.73 27.26 20.15 (-) 26
White 0.83 0.90 0.73 12.92 15.67 21
Brushy 0.88 0.91 0.79 26.07 27.83 7

0.96 0.85 0.81 19.76 21.97 11
Mean 0.85 0.80 0.65 - - 68

Field-
verified 

Length (km)

Model 
Length (km)

Model Length 
Error % 

Over/Under 
Predicted

Smokies High
Smokies Trans
Smokies Meta

Dysartsville



Area and Slope Method, T = 300

The area slope method with a threshold of 300 produced different results than the previous 

methods. When the threshold increased from 200 to 300, the TSS values increased for the watersheds 

with steeper slopes (South Mountain, Bent Creek, Smokies Meta, and Smokies High) and decreased for 

watersheds with lower slopes (Dysartsville, Brushy, Hayes, and White) (Table 11). The stream length 

percent error further explains this. The lower-gradient watersheds have underpredicted stream lengths 

and low sensitivity. This indicates a threshold of 300 for lower-gradient areas may be too high, and 

therefore it will underpredict the number of headwater streams. The TSS values for the watersheds with 

higher-gradient slopes are still extremely low, not the method did not produce accurate representations 

of stream networks for these watersheds. The threshold of 300 produced the best stream network for 

the Smokies Metasedimentary watershed than any other method. An increase of the threshold for the 

area and slope method may produce higher TSS values for these watersheds. A higher threshold better 

predicts headwater streams in areas with higher slopes than lower thresholds. 

Table 10. The table shows valley presence/absence and stream length accuracy assessments for 
the area and slope method when T = 300.
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Area/Slope T = 300
Presence/Absence Accuracy Assessment Stream Length Accuracy Assessment

Watershed Specificity TSS

South 0.71 0.77 0.49 18.00 27.71 54
Bent 0.62 0.89 0.50 21.34 30.90 45

0.77 0.75 0.52 4.49 9.11 103
White 0.67 0.96 0.63 12.92 12.22 (-) 5
Brushy 0.68 0.96 0.65 26.07 22.38 (-) 14

0.83 0.84 0.67 5.03 7.88 57
0.75 0.93 0.68 19.76 17.18 (-) 13

Hayes 0.83 0.85 0.69 27.26 12.84 (-) 53
0.77 0.96 0.74 4.98 7.25 46

Mean 0.74 0.88 0.62 - - 43

Sensitivty
Field-

verified 
Length (km)

Model 
Length (km)

Model Length 
Error % 

Over/Under 
Predicted

Smokies Trans

Smokies High
Dysartsville

Smokies Meta



DISCUSSION

The CGIA stream map worked better in open areas and watersheds that have lower slopes. The 

open areas make it easier to view the location of stream channels on aerial photography, hence the high 

TSS value for the Hayes watershed. In areas with lower gradients, it may be possible the stream 

channels are also easier to determine than watersheds with higher gradients. It may also be possible the 

reason the CGIA streamlines have different accuracies among watersheds is due to the relationship 

between the number of streams across a landscape and slope. It has been shown the number of streams 

is inversely related to the slope of a watershed (Tucker and Bras 1998). Watersheds with steeper slopes 

with have more concentrated flow with higher velocities than flows in watersheds with lower slopes. 

This will cause deeper, more incised valleys and a lower number of streams. The valleys may only 

support ephemeral flow, but in most cases, the flow regime of a channel cannot be determined by 

simply using aerial photography. It is possible that these ephemeral channels are being drawn in as 

intermittent or perennial stream channels on the CGIA stream map. Since CGIA tends to overpredict 

streams, the watersheds with higher gradients tend to have lower TSS values than watersheds with 

lower slopes. Since the accuracy of the CGIA streamlines seems to depend on the percent of open areas 

and slope, the TSS values are not consistent among watersheds within the same ecoregion. This is 

evident with the Eastern Blue Ridge Foothills ecoregion. 

The average TSS values of stream networks generated by the DEM curvature based method in 

TauDEM differ from the CGIA stream map by only 9%, but are also inconsistent among watersheds in 

the same ecoregion. The area and slope method with a threshold of 200 differed by only 12% from 

CGIA, but still had low and inconsistent accuracies. This is because only elevation and drainage area 

data are considered. In state with similar mountainous terrain, it may be possible to use elevation data 

to model stream networks in lieu of extensive stream mapping programs. Many states may lack the 
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funding and infrastructure to support such programs, but TauDEM may provide another way to make 

stream maps. While the stream networks created with TauDEM do not provide sufficient nor consistent 

accuracy to be used for regulatory purposes, they may be used in along with regulatory stream maps to 

provide a better idea of headwater stream locations.

CONCLUSION

The CGIA stream map does not depict headwater streams with a consistent level of accuracy 

among ecoregions, and therefore is not recommended to be used for stream regulation. However, the 

CGIA streamlines do provide accurate representations of streams in open areas, and therefore may 

work well for other purposes, such as planning for urban streams or restoring streams in open areas. 

The goal of the CGIA stream map was to upgrade the horizontal accuracy of stream maps, not to 

accurately depict the location of headwater streams. Based on the findings of this study, the CGIA 

stream map do not consistently show headwater streams within ecoregions, and for this reason, the 

HSSD will now begin working on logistic regression models for the five ecoregions for the nine 

watersheds.

The main focus of the HSSD is to improve headwater stream representation on maps used for 

research and regulatory purposes. Because other factors such as topography, climate, soils, geology, 

and vegetation contribute to the formation of headwater streams, simply using aerial photography or 

elevation data will not sufficiently nor consistently model stream networks (Tucker and Bras 1998). By 

using the field-mapped stream origins and GIS-derived data of watershed characteristic, the HSSD has 

the ability to model headwater streams at a more accurate and consistent level among ecoregions 

(Russell 2008). 
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Appendix 1. A map of areas with completed CGIA streamlines.
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Appendix 2. Procedure logs that explain each section from the METHODS in detail.

Creating DEMs

1. Go to ncfloodmaps.com > Data Download > County Data > LIDAR Bare Earth
2. Using the Elevation grid shapefile provided by the website and ArcGIS, determine which tiles 

to download 
3. Download file > The text file downloaded shows x, y, and z coordinates that represent the 

location and elevation of the bare earth points in feet
4. Convert x, y, and z coordinates into meters
5. ArcCatalog > New > Shapefile > Edit > Select XY Coordinate System > Projected Coordinate 

Systems > State Plane > NAD 1983 > NAD StatePlane North Carolina FIPS 3200.prj
6. ArcMap > Spatial Analyst > Topo to Rater > Cellsize (X, Y) 5, 5 for 25 meter resolution

Creating Field-verified Stream Networks

1. Go to hydrology.usu.edu/taudem/taudem4.0/index.html#intall > Download and install 
TAUDEM Version 4.0.6

2. Arc Map > Add Toolbox > Taudem
3. View > Toolbars > Customize > Terrain analysis using Digital Elevation Models (TauDEM)
4. Basic Grid Analysis > Select Base DEM Grid > use DEM created from LIDAR bare earth 

points
5. Basic Grid Analysis > Do All > Uncheck Check for Edge Contamination > Compute
6. Now, need to create an outlet shapefile:
• ArcCatalog > New > Shapefile > Edit > Select XY Coordinate System > Projected Coordinate 

Systems > State Plane > NAD 1983 > NAD StatePlane North Carolina FIPS 3200.prj
• ArcMap > Add Data > add outlet shapefile
• Editor > Start Editing > select outlet shapefile > Task: Create New Feature > place a point at the 

most downstream point of the stream network that includes the streams with mapped 
origins > use the ad8 raster created from TauDEM as guidance, the white lines are deep valleys 
and most likely stream locations > Save Edits > Stop Editing

7. Network Delineation > Select Outlets Shapefile > select the outlet shapefile that was created > 
Do All Network and Watershed Delineation Steps

8. Editor > Start Editing > select the new stream network shapfile > delete and add streamlines to 
mapped stream origins using the guidance of the ad8 and sd8 to place streamlines in line with 
the valleys > Save Edits > Stop Editing

Modeling Stream Networks in TauDEM

1. ArcMap > add all raster that were created using Basic Grid Analysis if they are not already > 
Select Base DEM > use DEM created from LIDAR bare earth points 

2. Network Delineation > Select Outlets Shapefile > select the outlet shapefile that was created
3. DEM curvature based:
• Network Delineation > River Network Raster Upstream Outlets > Stream delineation method > 

DEM curvature based > Check Use the range below to automatically select threshold by drop 
analysis > Check Upstream of outlets only > Uncheck Check for Edge Contamination > 
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Compute
4. Area and slope threshold for 150, 200, and 300
• Network Delineation > River Network Raster Upstream Outlets > Stream delineation method > 

Area and slope threshold > Uncheck Use the range below to automatically select threshold by 
drop analysis > Stream delineation parameters and settings: Threshold T: 150 > Exponent y: 2 > 
Check Upstream of outlets only > Uncheck Check for Edge Contamination > Compute

• Network Delineation > River Network Raster Upstream Outlets > Stream delineation method > 
Area and slope threshold > Uncheck Use the range below to automatically select threshold by 
drop analysis > Stream delineation parameters and settings: Threshold T: 200 > Exponent y: 2 > 
Check Upstream of outlets only > Uncheck Check for Edge Contamination > Compute

• Network Delineation > River Network Raster Upstream Outlets > Stream delineation method > 
Area and slope threshold > Uncheck Use the range below to automatically select threshold by 
drop analysis > Stream delineation parameters and settings: Threshold T: 300 > Exponent y: 2 > 
Check Upstream of outlets only > Uncheck Check for Edge Contamination > Compute

• Note: Some streamlines will need to be edited when they are thicker than 1 cell wide
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Appendix 3. A list of grids that are created in TauDEM using the Basic Grid Analysis function 
(Tarboton 2004).
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Name Suffix Input to Output from Description 

Base Elevation grid dem Fill Pits 

fel Fill Pits 

Flow Path Grid fdr Fill Pits 

fdrn Fill Pits 

p 

D8 Slope Grid sd8 

ang 

D-Inf Slope Grid slp A grid of slope evaluated using the Dinfinity method.

ad8 

sca 

gord River Network Raster 

tlen 

plen River Network Raster 

src 

ord A grid giving the Strahler stream order for each delineated stream grid cell. 

Watershed Grid w Watershed Grid to Shapefile 

Digital elevation model (DEM) grid to serve as the base input for the terrain 
analysis and stream delineation. 

Pit Filled Elevation 
Grid 

D8 Flow Directions, Dinf Flow Directions, River 
Network Raster 

Grid of elevation values with pits filled. This is usually the output of the "Fill 
pits" function in which case it is elevations with pits removed. 

A grid giving flow directions used to impose existing streams into the 
system. This uses the D8 direction encoding, i.e. 1 - East, 2 - North East, 3 
- North, 4 - North West, 5 - West, 6 - South West, 7 - South, 8 - South 

East. No data values should indicate off stream locations. 

Verified Flow Path 
Grid 

D8 Flow Directions, Dinf Flow Directions, River 
Network Raster 

A grid giving flow directions used to impose existing streams into the 
system. This uses the D8 flow direction encoding, i.e. 1 - east, 2 - North 
east, 3 - North, 4 - North west, 5 - West, 6 - South West, 7 - South, 8 - 

South east. No data values indicate off stream locations. 

D8 Flow Direction 
Grid 

D8 Contributing Area, Flow Distance to Streams, 
Grid Network Order and Flow Path Lengths, 
Stream Order Grid and Network Files, River 

Network Raster, Stream Shapefile and 
Watershed Grid, Watershed Grid to Shapefile 

D8 Flow 
Direction 

A grid giving flow direction by the D8 method. The encoding is 1 - east, 2 - 
North east, 3 - North, 4 - North west, 5 - West, 6 - South West, 7 - 

South, 8 - South east. 

D8 Flow 
Directions 

A grid giving slope in the D8 flow direction. This is measured as 
drop/distance. 

D-Inf Flow 
direction Grid 

Dinf Contributing Area, Decaying Accumulation, 
Upslope Depencence, Downslope Influence, 
Reverse Accumulation, Concentration Limited 

Accumulation, Transport Limited Accumulation 

Dinf Flow 
Directions 

A grid giving flow direction by the Dinfinity method. Flow direction is 
measured in radians, counter clockwise from east. This is created by the 

function "Dinf flow directions". 

Slope/Area (Wetness Indicator), River Network 
Raster 

Dinf Flow 
Directions 

D8 Contributing 
Area Grid 

Stream Order Grid and Network Files, River 
Network Raster 

D8 Contributing 
Area 

A grid giving the contributing area evaluated by accumulating the area or 
weight loading upslope of each location, measured as a number of pixels or 

sum of weight loadings. This is created by the function "D8 contributing 
area" 

D-inf Specific 
Catchment Area 

Grid 

Slope/Area (Wetness indicator), River Network 
Raster 

Dinf Contributing 
Area 

A grid giving the contributing area evaluated by accumulating the area or 
weight loading upslope of each location, using the Dinf algorithm. If weights 
are not specified this is measured in specific catchment area units, i.e. area 

per unit contour width, using grid cell as the unit width and grid cell size 
squared as grid cell area. Created by the function "Dinf contributing area" 

Strahler Network 
Order Grid 

Grid Network 
Order and Flow 
Path Lengths 

A grid giving the Strahler stream order for each flow path. Strahler order is 
defined as follows. Source streams (or flow paths) are first order. When 

two or more flow paths of the same order join the outgoing path has order 
one higher. When high order paths flow in to low order paths the order 

remains the same. 

Total Upslope 
Length Grid 

Grid Network 
order and Flow 
Path Lengths 

A grid that gives the total length of upslope flow paths terminating at each 
grid cell. 

Longest Upslope 
length Grid 

Grid Network 
order and Flow 
Path Lengths 

A grid that gives the length of the longest upslope flow path terminating at 
each grid cell. 

Stream Raster Grid 
Stream Order Grid and Network Files, Flow 

Distance to Streams 
River Network 

Raster 

A grid indicating streams, by the grid cell value 1 on streams and 0 off 
streams. This is created by the function "Full river network raster" or "River 

network raster upstream of outlets" 

Network Order 
Grid 

Stream Order 
Grid and Network 

Files 
Stream Shapefile 
and Watershed 

Grid 

A grid demarcating each reach watershed. This is created by the function 
"Stream Shapefile and Watershed Grid" 



Appendix 4. A map of the South Mountain watershed that shows the location CGIA streamlines 
in comparison with field-mapped data and land cover.
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